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1 Overview of CHIPwit with function descriptions and overall system design 2
A CHIPwit  Pro uses an Excel workbook template with specially-designed 

worksheets and macros to automate administration of the CHIP intensive lifestyle 
education program. The macro-free basic version does many of the same things, but 
without macros. The basic version is simpler but requires more manual operations.

B The following administrative functions are automated: 
1 participant enrollment (Information sessions), 
2 before and after risk factor assessment and feedback (HeartScreen #1 and #2), 
3 storage and transmission of participant data to a central database (CHIP Export), 
4 summation of results for presentation (CHIPwit Powerpoint), 
5 and recording and printing follow-up measures.

C CHIPwit  Pro automatically updates the Summary workbook and the presentation 
Powerpoint with information about each particpant for each session. (Macro-free 
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version does not include these features.)

2 Starting a new Chapter 3
A The CHIPwit  software is distributed ready to use. Before opening it, copy it to a file 

folder where you will keep all the workbooks for the new chapter. (e.g. 
C:\...\My Documents\Anycity CHIP) 

B The file is password protected and can only be opened using a valid chapter code.  
It is also 'Read-only' and must be saved using 'Save-As' with a new name. 

C After opening the Excel file (use chapter code for the password), tab to the 'Session' 
worksheet and register the chapter by completing the top section of the worksheet.

D Headings for the participant forms may be modified using the "Print Headings" fields. 
What is entered in these fields is shown in the headings for the participant forms.

E Up to five "address short-cuts" may be created by completing the City Short-cut Table.
F Under the City Short-cut Table is the "Optional Fields" block. Entering a "Y" in any of 

the four optional fields will activate those field(s) for use during HeartScreens. Fields 
not containing a "Y" will not be shown on the forms and cannot be used.

G Save the workbook (using Excel 'Save-As') with a suitable name so it can be used 
to register each new CHIP session. (Save the file with a 'Read-only password to 
avoid unintentional changes to the master.)

H A temporary authorization code of '99999' can be used to register the chapter but 
must be updated to continue using production copies of the software.

3 Starting a new Session 4
A New CHIP sessions can only be registered after the new chapter is registered. (see 

section #2.C above) CHIP sessions can only be started (registered) using the chapter 
Master workbook that was saved after a valid Chapter Code was entered. (#2.G)

B Each new CHIP session conducted by the chapter is saved as a separate copy of the 
workbook with a unique filename identifying the session (e.g. 'CHIP-1') which can be 
personalized. (e.g. 'CHIP-1, Sometown Oct-09') Do not use pound sign ("#") in the name.

C Any number of sessions can be registered by a single chapter, so there is essentially 
no limit to the number of sessions available. Each copy of the software has a maximum no limit to the number of sessions available. Each copy of the software has a maximum 
number of participants, the capacity of the workbook. CHIPwit Summary is a workbook 
that combines multiple workbooks into one group. (CHIPwit Pro has unlimited capacity.)

D New sessions are registered using the bottom section of the 'Session' worksheet each 
time a CHIP program is organized and conducted. All of the information is required for 
proper processing of the session. (Fees and HeartScreen appointment data is required 
before the blank Registration and HSBlank forms can be printed.)

E Information from previous Session workbooks may be imported to register new sessions 
using the 'Session to Import' function on the 'Session' worksheet.
This feature allows the following data to be imported from CHIPwit  workbooks:
1 City-State Shortcuts
2 Heartscreen Stations (optional)
3 General Session information (address, configuration)
4 CHIP meeting Calendar structure (optional)
5 Fees

F The dates of the program are validated to minimize data entry errors. The date for 
HeartScreen #1 should be no more than 9 days prior to the Start date for the program. 
The End date must come after the Start date, and the HeartScreen #2 date should be 



not more than 7 days before the End date. 
G The Calendar is automatically marked with the HeartScreens and Start and End dates. 

Meeting dates between the Start and End dates may be "marked" by clicking on the 
cells with the desired dates and hitting 'F9' to change the formula into text and then 
hitting 'Enter.'  Dates are unmarked by clicking the cells and turning the contents into 
text by typing a single quote (') in front of the date value. (Unmarked dates can be mark-
ed again [toggled] by removing the leading single quote to turn the text into a number.)

I Marked dates are shown with gray shading. HeartScreen dates are shown with orange 
shading, and Graduation with green shading.

J Until the correct number of dates are marked, the meeting count cell shows orange 
shading to indicate all meetings are not yet marked on the calendar.

K The dates marked show on the 'Table' worksheet roster where attendance and miles 
are recorded  for each table at each meeting. Use the 'Calendar' worksheet to view 
and print copies of the calendar.

4 Preparing for Information sessions 5
A New participants are typically enrolled in the CHIP program (session) at the close of 

an Information session using a Registration form. A blank Registration form is printed 
for each new CHIP session and used to register participants at Information sessions. 
The 'Registration' worksheet is used to print the blank form. (Additional 
copies can be printed anytime using the Excel-Print function.)

B Those who wish to enroll fill out a blank Registration form with their name, status, fees 
and other information. The completed forms are entered into the workbook to enroll 
participants at the close of the Info session and a personalized HeartScreen form is 
printed for them to complete. (Alternatively, a blank HeartScreen form may be given to 
enrollees and all data may be entered later. (see section #5 below) 

5 Adding a new Participant (Enrollment) 6
A The completed Registration form is used at the close of the Information session to 

enroll (add) new participants in the workbook for the session. (The CHIPwit  workbook enroll (add) new participants in the workbook for the session. (The CHIPwit  workbook 
should be open before proceeding.)

B Registrants are enrolled by entering information from the Registration forms, beginning 
with the first participant worksheet, '1', and proceeding with each numbered worksheet 
in order. (e.g. '2', '3', etc.)

C Enter information from the completed Registration form into the worksheet. (worksheet 
forms look just like the paper forms) Information from the paper form can be typed 
directly into the worksheet, or the dataform links provided in column-A can be used to 
enter data. The dataform column [col-A] is hidden when dataforms are not utilized. 

D (The two methods can be mixed during data entry, but anything entered directly into the 
worksheet must  be copied to the dataform before using it. Thus, when data has been 
entered into the worksheet, additional steps are required before using a dataform link. 
These steps will be automatically displayed and must be performed before using a 
dataform after entering data directly into the worksheet.)

E The HeartScreen appointment time slot selected by the enrollee is entered on the 
Registration form and entered into the worksheet form.

F After all information is entered, the HeartScreen #1 lifestyle assessment form is printed 



and given to the participant to complete and bring to the HeartScreen event.
Alternatively, a blank master form can be printed using the 'HSBlank' worksheet 
and given to participants so nothing need be entered into the computer at the Information 
sessions. (Using this approach, data entry is batched after HeartScreen #1 and before 
distributing the evaluations to participants.)

G The form is given to the participant to fill out and bring to HeartScreen at the 
appointed time. The form contains participant name and appointment -- everything 
is on the one paper form that includes a section to record their medications. 

H Text on the participant forms can be revised on the template worksheet, "0". Changing 
the text on the template will result in changing the text on all participant worksheets.
Text labels for risk stratification bar graphs can be revised on the 'Group' worksheet.

6 Preparing for HeartScreen #1 7
A HeartScreen #1 is conducted to measure beginning risk factors. This is done using a 

series of stations where various biometric measures are made, recorded and reviewed.
B Participants are scheduled to arrive in blocks every 15 minutes at a rate intended to 

match the rate at which measures can be collected. Typically the blood draw station is 
the rate-limiting step. (the one that limits the workflow) The maximum number of partici-
pants to schedule in a 15-minute block is specified on the 'Session' worksheet form (cell  
$E$23). A single phlebotomist can typically complete 3-4 blood draws every 15 minutes.

C The list of stations and the measures taken at each is specified on the 'Session' 
worksheet form and shown on the 'HeartScreen' worksheet form. The list can be revised 
to reflect whatever arrangement best suits the team. 

D The printed posters contain a large digit and the task list to identify the various 
stations and guide traffic during the heartscreen event. (see    pix)

E A page is printed along with the posters listing the heartscreen stations with blank 
lines to write in the name of the responsible person for each station. This list is used 
by the team and the person supervising the event. The list and the signs are printed 
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by the team and the person supervising the event. The list and the signs are printed 
using the Excel Print function. (see    pix)

7 Entering data during and after HeartScreen #1 8
A Participants must bring the completed HeartScreen assessment form received at the 

Information session. If they forgot the form, another copy is printed and given to them 
to complete before they can register for HeartScreen #1.

B The assessment form includes a gray-shaded box for recording measures during 
HeartScreen. The form is carried from station to station by the participant. Each 
station takes the measures and records them in the proper place on the form. 

C The form can be entered into the workbook while the participant is eating breakfast. 
All data should be entered before the form & medication review where it is checked 
for completeness. 

D HeartScreen data is entered by clicking on the workbook tab for each participant and 
either typing directly into the form or using the dataforms hyperlinked in the 'Forms &
Links' column.
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G Vitals and labs are entered by typing them directly into the workbook form or by using 
the dataforms hyperlinked in the 'Dataform Links' column-A.

H Medication "MedType" is entered using the drop-down lists for each medication line. 
For many medications this is all that is required, although you may wish to enter dosing 
and/or medication name. Medications are selected from the drop-down list or typed into 
the field. Reason and dosing is usually suggested with the medication selected from 
the list. Medication reasons recognized and tracked by CHIPwit  are shown in bold 
italics. Missing information is indicated by orange shading in the field.

I The "medication review" station reviews the medications and chooses the two 
primary goals for participation. It typically also includes distributing and explaining the 
JumpStart booklet. 

J Everything but labs should be collected and entered into the workbook during the 
HeartScreen event. The labs are typically received a few days after the blood draw.
If they are available in electronic form, they can be imported into the 'Labs' worksheet 
form as a text or spreadsheet file and then parsed into the lab table with cell formulas. 
If the labs are only available in paper form they may be entered into the lab table in 
the 'Labs' workbook form or entered directly into the worksheet forms for each 
participant.

K Lab values entered directly into the worksheet form are shown in bold and take 
precedence over values entered into the lab table in the 'Labs' workbook form.

L After all data is entered into the workbook for all participants, you are ready to proceed 
to the next step -- the lifestyle evaluations.

M Pop-up helpnote comments are displayed by gliding the pointer over the fields on the 
form. (helpnote comments can be edited after unprotecting the worksheet)

N By the second meeting participants should have selected the table they will sit with for 
the remainder of the program. Table assignments are entered into the 'Participants' 
worksheet form. Once the tables are entered, a summary list appears showing the 
number of participants at each table and the total miles from the "Today" column for number of participants at each table and the total miles from the "Today" column for 
the table. 

O Miles are tallied on the 'Participants' worksheet form by typing directly into the 'Today' 
column of green-shaded cells [col-K]. The 'Total' miles column [col-L] must be updated 
with the 'Today' miles before entering more miles. (Always enter miles only into blank 
cells to avoid losing miles in the 'Total' column [L].) 

P Miles are entered from the attendance / exercise records for each participant. Miles 
may be entered for each meeting, but total miles can also be entered only at the end of 
the program. When miles are entered, CHIPwit tallies them to make awards. Miles 
entered in the 'Today' column are totalled for each table in the table list. The table with 
the most miles is flagged with '**' and the table with next most miles with '*'. The mascot 
can be given to the table with the most miles to encourage physical activity.  

8 Using the Labs form to enter or import electronic lab reports 9
A This function is fully automated in CHIPwit  Pro. (see item #8.C below) The 

following section describe the process used in the standard version of the software.



B The printed lab results may be entered directly into each participant's worksheet form 
or all lab reports can be entered into the 'Labs' worksheet form where they will be 
picked up by each participant's worksheet form, thus saving data entry time. 
The 'Labs' worksheet form includes a row for each participant. Enter the beginning lab 
values in the left columns and the ending lab values to the right of that. (see headings 
on the form) If a digital lab report is available it may be used to 'Copy-Paste' lab values 
into the assigned cells in the 'Labs' form instead of typing them.

C CHIPwit  Pro provides features to automatically import electronic lab reports into the 
workbook, eliminating manual data entry. Once this process is established it is 
automatically repeated for all subsequent CHIP sessions using the same laboratory. 
(Macros parse digital data to separate it and identify the labs.)
First, download the electronic file to your computer, usually in the CHIP Session folder. 
(This file can be deleted later.) Then open the active CHIPwit Session and, from within 
Excel, open the file with 'File-Open…'. Select the proper file type (text or Excel, etc.) 
and then select the saved file. (see    pix) When opening a text file, delimeters must be 
specified to properly parse the data. (see              pix) 

D After the file is open, move it to the end of the CHIPwit workbook using the 'Edit-Move 
or Copy Sheet…' function and selecting the CHIPwit workbook. (see              pix) 

E Once the file is moved into the workbook, the worksheet name must be typed into the 
top row of the 'Labs' worksheet form to activate automated parsing. The 'Labs' work-
sheet form contains two green-shaded boxes at the top, one for HeartScreen #1 and 
one for HeartScreen #2. The names of the electronic/digital files imported are typed 
in these boxes. (see    pix) Once that is done the parsed lab values should appear in 
the cells below the yellow headings, (see    pix) and also in the appropriate workbook 
HeartScreen forms. (see    pix)

F If the lab values do NOT appear, something may have gone wrong during the importing 
process. The wrong file may have been opened, or improper delimiting may have been 
selected, etc. Maybe the file format is one CHIPwit cannot handle. If that is the case 
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selected, etc. Maybe the file format is one CHIPwit cannot handle. If that is the case 
you will need to contact the CHIPwit support team for assistance.

G The lab values can be entered into the cells manually, or even into the individual 
participant worksheet forms. This is not intended to be the usual method but is 
provided for backup, and when late or corrected labs are received separate from the 
file already imported. (CHIPwit cannot handle more than one file for each lab report)

9 Preparing and printing Lifestyle Evaluation #1 10
A All information from HeartScreen, including labs, must be entered and complete before 

the evaluations can be prepared and printed. Review the 'Participants' and 'Missing' 
worksheets to see what may be missing. Click on the "X"s to scroll to the actual fields 
involved and make any needed changes. (use the 'Missing' link to return)

B Review each participant's worksheet (e.g. '1', '2') evaluation form (page 3) and make 
any revisions. Evaluation feedback is provided automatically using Excel formulas. All 
of these annotations can be altered by typing over them.

C Red ovals or other graphics can be added by pasting and formatting them to flag the 



desired fields. Wordart comments can also be pasted to provide high-impact feedback.
D Individualized comments are automatically entered below each of the two primary goals 

selected by the participant. These may be manually revised by the reviewer before 
printing the evaluations for distribution.

E After all revisions are made for each participant in turn, click the Evaluation#1 link at the 
top of the worksheet to select the pages to print for evaluation #1. (pp. 3-4) If you do 
NOT select the desired pages you cannot use the "Selection" option when printing! 
After revising the evaluations for all participants not "dropped," you are ready to print the 
evaluation forms for distribution. Use the Excel Print function (Office button) to print the 
completed lifestyle evaluation #1 forms (pp. 3-4).

F To print more than one participant at a time you must have the desired pages 
selected on each worksheet to be printed and use the "Selection" option under "Print 
what" on the Print dialog box. (section 9.E above) Select multiple worksheet tabs (click 
the leftmost tab and scroll the rightmost worksheet tab into view, then hold down 'Shift' 
while clicking the last tab) and perform the Excel Print function (using Office button). 
Choose "Selection" under "Print what" and choose the desired printer and number of 
copies. If you do NOT choose "Selection" in the "Print what" section, all pages for each 
worksheet tab selected will print! Choose the desired printer and # copies.
(Click "Preview" to review the pages before printing to avoid unintended mistakes.) 

G If the forms are to be emailed to participants, they should be converted to a suitable 
format such as an Adobe PDF file. (This can be done with a file conversion program 
such as  'PDF Creator.') Each worksheet must be prepared separately for emailing so 
participants receive ONLY their own evaluation forms.

H Two copies are usually printed for each participant, one for the participant and one for 
their physician. Extra copies of the form(s) can be printed later using this same routine.

I Headings for the forms are defined on the 'Session' worksheet and may be edited 
there. (see #2.E above) The left heading defaults to 'Organization name' and 'Phone'; 
the center heading to "CHIP Lifestyle Evaluation"; the right heading to 'Line 1 address' the center heading to "CHIP Lifestyle Evaluation"; the right heading to 'Line 1 address' 
and 'City, State Zip'. These default headings can be changed by typing the desired text 
and/or formulas into the appropriate fields on the 'Session' worksheet.

10 Preparing for HeartScreen #2 11
A After the lifestyle evaluations are distributed and before the second heartscreen event, 

HeartScreen #2 assessment forms need to be printed and distributed to the partici-
pants. Use the Excel-Print function to print page 4 of the worksheet forms. ('1', '2', etc.)

B These forms include the participant's name, appointment time and medical conditions 
from HeartScreen #1. The dietary, rest and stress, exercise and medication fields are 
blank and ready to be filled in.

C The forms should be completed by the participant and brought to heartscreen #2. 
If the completed form is not brought another copy may be printed from the workbook 
and completed before proceeding to the heartscreen stations.

11 Entering data during and after Heartscreen #2 12



A The process is a repeat of step #7 with heartscreen #1. The assessment forms include 
information from heartscreen #1 such as disease conditions, smoking, goals and 
medications. Information that does not change need not be entered again.

B Heartscreen data is entered by clicking on the workbook tab for each participant and 
either typing directly into the form or using the dataforms shown on the right. [col AE]

C Some fields are included that are not present on heartscreen #1. Medication dosing 
from heartscreen #1 is shown with a column for current dosing to be filled in. Dosing 
can be entered as 'same' or 'no change' if there are no changes, or as 'none' or '0' if the 
medication has been stopped. New medications can be added below the list of 
medications from heartscreen #1. (It is important to record all medication dosing 
accurately and completely.)

D The labs are entered as with HeartScreen #1 (item #8 above), importing electronic data 
when possible. (Similar cell formulas can be used to format the labs in the 'Labs' 
worksheet table as used with HeastScreen #1.)

E When all data is entered into the workbook forms you are ready to prepare evaluations.

12 Preparing and printing Lifestyle Evaluation #2 13
A The process is the same as for Lifestyle Evaluation #1 in step #9 above. (9.A - 9.G)

Lifestyle Evaluation #2 (page 5) also includes a summary of changes. (pp. 6-7)
included with Lifestyle Evaluation #1 (page 3).

B If the Beck Depression Inventory and/or the Rand SF-36 Questionnaire is used, this 
step will also include preparing and printing the 'SFBDIs' worksheet scores for each 
participant.

C The average scores for the group are included in a scoring form that may be printed and 
distributed to each participant. Use the Excel-Print function to print the 1-page per 
participant report. The Standard function questionnaire measures eight components of
health and function. The Beck depression inventory is the accepted measure of clinical
depression. Scores are standardized to 100%.

#9

depression. Scores are standardized to 100%.

13 Preparing for the "results" event (graduation) 14
A In addition to the lifestyle evaluations from heartscreen #2, there are a number of other 

items that must be prepared for the Graduation event.
B Use Excel-Print function to print the'Group' worksheet summary totals for the group.

This summary shows the averages for the Session. (weight change, blood pressure 
change, etc.) The 'Charts' worksheet contains barcharts of the group summary that 
may be printed or copied to a PowerPoint slide to share at Graduation.

C Use the 'Certificates' worksheet to print a certificate of completion for each qualifying 
participant. Enter an ID# in cell 'D9' and use the Excel-Print function to print a certificate. 
(Participants who have been 'dropped' typically do not qualify for certificates.)

D Use the 'Awards' worksheet to prepare and print recognition awards for participants. 
This worksheet contains eight (8) pages with a different award on each page, and a 
blank award on page 9. 

E Awards are assigned to participants by CHIPwit based on the changes in their risk 



factors shown in the 'Participants' worksheet. (flagged with '**') Individuals qualifying 
for multiple awards are only awarded for their top performance and other awards are 
assigned to those who do not have any awards. (This may result in individuals getting 
an award who did not have the greatest improvement, and honorable mention is made 
of those with equal or greater improvements.) These individuals are flagged with a single 
asterisk ('*') in the 'Participants' worksheet. A separate award is made for men and for 
ladies for most miles walked. The ladies are flagged with plus signs. ('++' and '+')

F Award assignments are altered by making changes on the 'Participants' worksheet.
Awardees and runner-ups are listed at the bottom of the worksheet. (see    pix)
Changing these ID#s will assign the awards to the the ID# entered under each risk 
category shown. Awards that are not desired may be discarded or not printed.

G A program evaluation survey should be completed by each participant at one of the last 
meetings. A suggested questionnaire is included with CHIPwit. ('USurvey.docx')

H The 'USurveys' worksheet may be used to tabulate responses to better assess the 
strengths and weaknesses of the program. The questions are listed in rows and 
participants are grouped by table in columns. Totals are calculated for participants and 
tables, and overall.

14 Exporting and sending the CHIP Assistant data 15
A At the end of the CHIP session, data is extracted and prepared for transmission to the 

central CHIP databse. The necessary file is prepared using the 'Export' worksheet.
Dropped participants and unused records are deleted from the exported data.

B Confirm that all information has been entered and the lifestyle evaluations are complete 
before proceeding. Follow instructions in the helpnote to enter the date in text format  
into the upper-left cell, 'A1.'

C Copy the 'Export' worksheet (use 'Copy/Move sheet' under 'Format' on the 'Home' tab)
to a new book, leaving the original in CHIPwit with the date in text format.

D Select and 'Copy' all rows, then do a 'Paste-values' to remove all formulas. Sort the 
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D Select and 'Copy' all rows, then do a 'Paste-values' to remove all formulas. Sort the 
rows by column-A in descending sequence to put the unused and dropped records at 
the bottom. Then select and delete any records with a "1" in column-A in the bottom rows. 

E Finally, delete column-A and save the new workbook with a suitable name to identify it 
for emailing it to the CHIP database. ("CHIPwitAsst.xlsx") This file should be attached to 
an email and sent to the designated email address given in CHIP materials.

F CHIPwit  Pro will export data to the CHIPwitSummary and CHIPwitPPTemplate 
files as well. (see topics #16 & #17 below)

15 Preparing for, entering and printing Follow-up measures 16
A Follow-up measures may be collected on the last page of each participant's worksheet. 

('1', '2', etc.) Use the last page (p. 9) of the participate worksheet to record and print 
follow-up measures for each participant. 

B Up to three follow-up blood tests can be entered into the final page of the worksheet. 
The 6-variable line graph updates automatically and prints when the page is printed. 

C The forms are printed using the Excel File->Print function. (see section 9.F above)



16 Using the CHIPwitSummary workbook 17
A Data from CHIPwit  workbooks is exported to the CHIPwit  Summary workbook by 

the 'Export Data' function. (A CHIPAsst file is also created for emailing to the central 
CHIP database.) This function requires you to identify the Summary workbook to open 
and export data into. (The Summary workbook contains a macro that can import data 
from CHIPwit  workbooks, as well.)

B The Summary workbook consists of four components:
1 A master list of all sessions contained in the workbook, with the date imported 

and descriptive information including session dates and name and size
2 A set of worksheets with stratified data and charts for key risk factor measures 

(e.g. BMI, FBS and TChol)
3 A worksheet containing all data imported from CHIPwit  workbooks in the same 

format as the 'Data' worksheet in CHIPwit
4 Macros to manage the workbook, including importing ('ImportSession') and 

deleting ('DeleteLast') sessions
C The Summary workbook aggregates CHIP Sessions into a combined database to 

analyze data across multiple sessions. It is used to aggregate all sessions for the 
chapter. (It can also be used to aggregate multiple chapters for larger-scale analyses.)

D An empty Summary workbook is distributed with CHIPwit  Pro and may be used 
to make as many copies as desired to aggregate data across different sessions and 
chapters. The original copy should be used only to make additional copies for use.

17 Using the CHIPwitPPTemplate PowerPoint  (CHIPwit  Pro only) 18

18 Processing external measures  (CHIPwit  Pro only) 19
C The SF-36 (Rand v1) and BDI-2 (Beck Depression Inventory, v2) are automatically C The SF-36 (Rand v1) and BDI-2 (Beck Depression Inventory, v2) are automatically 

included as external measures and may be used to collect measures of health status 
during the HeartScreens. The questionnaires are distributed with the HeartScreen 
assessment form and completed by the participant to be turned in at HeartScreen.

D In CHIPwit  Basic, responses are entered using the 'SF36' and 'BDI2' worksheets. In 
CHIPwit  Pro responses are entered using the external measures data entry 
forms executed with the 'Enter Data' function buttons on 'SF36' and 'BDI2' worksheets. 

E Summary scores are shown on the lifestyle evaluation forms and a 1-page interpretative 
report is provided for each participant using the 'SFBDIs' worksheet . 

F Full data collection for research purposes is provided by collecting complete individual 
responses. (The data can be exported for use in other software using Excel features.)

19 Helpful Hints and shortcuts 20
A Create a file folder for each new chapter and copy the files distributed with CHIPwit 

into the folder. To register the chapter, 'Open' (execute) the CHIPwit.xlsx file.
B Each session will create a new copy of the CHIPwit workbook. A new file folder may 



be created for each new session with its workbook, but it will be simpler to keep all 
session workbooks in the chapter file folder. 

C CHIPwit  Pro customizes the right-click shortcut menu to quickly find help and 
navigate. The shortcut menu options and their functions are listed below.
1 Popup help -- this menu option displays and updates the "post-it" help notes on 

the heartscreen forms. (It is equivalent to clicking 'Help' on the heartscreen forms.)
2 Expand/Collapse form -- this menu option expands and collapses the heartscreen 

forms for viewing portions of the form not in use for the current CHIP process. (It 
is equivalent to clicking 'Exp/C' on the individual participant worksheet forms.)

3 GoTo… -- this menu option offers a drop-down list for navigation to the various 
worksheets/forms in the workbook.

4 Paste… -- this menu option offers two selections, one to paste red rectangles and 
another to paste wordart comments to the lifestyle evaluation forms.

D In CHIPwit  Pro the right-click menu can be turned 'on' and 'off' by clicking the toggle 
button at the bottom-right corner of the 'TaskList' worksheet control panel. The toggle 
setting is retained when the workbook is closed and re-opened.

E The pop-up Post-it helpnotes for cells in the participant HeartScreen forms are stored 
in cell comments in the worksheets. These helpnotes provide contextualized help for 
data entry and completion of the lifestyle evaluation forms. 

20 Programming technicalities and other information for "nerds" 21
A The 'Tools->References' in the Visual Basic Editor window must be set to include 

Powerpoint and Excel in both PowerPoint and Excel libraries for the macros to work 
since these macros must execute across applications.

B The macros are digitally-signed so they do not trip security protection when opening 
these documents after the certificate is once accepted.

C The documents and workbook are protected to prevent accidental alteration of 
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C The documents and workbook are protected to prevent accidental alteration of 
protected cells and information. (e.g. formulas) Passwords are not used for some of 
the worksheets commonly needed so the worksheets can be unprotected and altered. 
Exercise extreme caution and care -- there are many very complex and inter-related 
formulas in the workbook.

D The '0' worksheet serves as the master template for participant worksheets ('1', '2', etc.) 
It also serves as a repository to restore cell formulas after the dataform is populated 
with any data entered directly into the worksheet and executed to provide data entry 
using the dataforms.

E Some dataforms are generated using separate worksheets in the workbook to avoid 
confusion on the part of the Excel showdataform function. These worksheets are 
hidden and are not made visible when the dataforms are executed.

F Most data is stored in the data rows of the dataforms in the participant worksheets. 
Relevant medications are summarized in the database ('Data' worksheet) but detailed 
medication information is not stored anywhere besides the individual heartscreen forms. 

21 Using Progress notes  (CHIPwit  Pro only) 22



22 Adding new Medications and Goals to the Lists 23
A All participant worksheet forms use the medication and goal lists in the 'UserGuide' 

worksheet to lookup relevant information. The lists should be kept sorted in ascending 
sequence.

B Use the 'Meds' and 'Goals' hyperlinks in the top panel to scroll to the list of interest. Then 
use the 'Insert' hyperlink to scroll to the proper cells to insert for a new entry. After 
using 'Insert cells' on the 'Home' tab (use the 'Shift cells down' option), enter the 
appropriate information.

C For medications, enter the name in the first column, typical indication (reason for taking) 
in the second column, "=ROW()" in the third column, typical dosing (mg, IU's, etc.) in 
the fourth column, and frequency in the fifth column. (When there is no "typical" dose or 
other information, just leave the fourth column blank.)

D For goals, enter the goal and specific lifestyle instructions important in achieving the 
goal. (Try not to duplicate the instructions used for other goals.)

E After new entrys are complete the list should be sorted in ascending sequence. This is 
best done by clicking the 'Sort' hyperlink in the top panel (for Meds or Goals) to select 
the proper list, and then use the A-Z ascending sort option on the 'Data' tab.

F You will need to 'Unprotect' the worksheet to make the changes. Be sure to 'Protect' 
the worksheet after making the changes.

23 Appendix and glossary TOC
A 1 Add participant Function used to add participants to CHIP sessions

2 Authorization code Code required to register a new CHIP chapter using CHIPwit
B 1 Beck Depression InventoryA questionnaire used to assess clinical depression

2 Blank forms Blank forms are provided for Info sessions, Table miles, 
and HeartScreens (when unable to update in realtime)

C 1 Calendar Calendar is provided to plan the CHIP meetings & eventsC 1 Calendar Calendar is provided to plan the CHIP meetings & events
E 1 External measures Measures not included in the HeartScreen assessment
I 1 Import Session Function used to copy information from previous sessions
M 1 Miles Activity is recorded as miles in the 'Participants' worksheet
S 1 SF-36 A questionnaire used to assess general health status & function

Z 99 placeholder - end of Glossary
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